JKBMS Tutorial
Setup

This tutorial will take you through the basic steps for creating a BMS database.

A BMS database must contain at least one root object. Further objects are added to the tree to
represent the distribution of the data, either by location or relationship, or both. As each object
is added, specific properties are entered to create records of the blasts. Other files are added
to build a complete history of blasting operations.

The first step is to start the program. Enter a name on the start screen — this will be the name of
the user profile. This is used to recall the last settings for that profile.

If this is the first time that the BMS program has been used after installation, it should ask you
several questions about storing the profile and file associations. If it does not, or if you wish to
change them, check the options under Program Settings.

New Database

To create a new database, [click] the button on the toolbar or select >File >Create New Db.
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You will be prompted to enter a name for the new database, and select a folder. The BMS
database canm be stored anywhere on your computer system.

Alternatively, you can objects to the current BMS database.

Root Object

If you have created a new database, the [Add New Root Object] button on the main toolbar will
be turned on. This means that you must create at least one root object for the new database.
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If the button is not on, [click] it to turn it on. Now, [click] any button in the object toolbar to create
that item as a new root object.

In general, start with a site (circled above) as a root object, and then add further objects to
represent the structure of the mine.

To change the name of an object, [right-click] the node and select >Rename Object from the op-
up menu.

You can add as many root objects as you wish to the tree.
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Add Object
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To add objects as nodes, first select
the parent node on the tree by a ” File Edit Properties Add Objects Tree Options Tools Help

single [click] on the node. Then, FH R e T =) )
[click] one of the icons in the object

toolbar to add that as a child node @ @& J 9 Caa O SBEH W
below the selected node. B 8 ¥ % M b d £

To add another object as a child to the | =@ NewSite

same node, [click] the desired icon in B @ r"lE"""F""F' N

the object toolbar. You can add as L = NZE B:r:';': e

many nodes as you wish at one time, T . Mew Bench

including duplicates of any object. _ @ Mew Open Fit

As it is added, each node is assigned

a unique ID number in the BMS

database. The ID number, object type

and object name are displayed in the
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when the node is selected.

The main concern at this point is to create a reasonable hierarchy for the tree that represents
the structure of your mine. This will make it easier to quickly locate information in the tree,
which could be crucial to the correct design and recording of blasts. It is possible to modify the
tree later, but good planning now is a better approach.

When the initial tree structure is complete, select each node in turn, press [F2] or [right-click]
and select Rename Object, and enter the name for each node.

To sort the tree, select >Tree Options >Rebuild. This will sort all objects at each level attached
to a node according to the selection in >Tools >Options. The figure below shows the result for
[Type and Name].

In this case, the mine has two pits.
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A geotechnical unit is a zone of rock
types and joints that is treated as a
single domain for blasting. Its
purpose is to quickly provide

information about the rock mass, for | o ~ Bench 115
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also add child nodes for rock types
and joint sets. The geotechnical unit
displays specific properties for the
dimensions of the domain, plus a ID:5 | Bench | Bench 100 A

summary of the specific properties
from child nodes for rock types and joint sets.
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The objects can be added to the tree in almost any sequence. For this example, the
geotechnical unit could have been placed immediately under the site, if it is large enough to
encompass the entire pit. However, if a pit has more than one domain, then the domains could
be placed inside the pit. Alternatively, all geotechnical units could be placed in one branch
together, separate from the other data, to reduce clutter in those branches and to make it easier
to find and maintain that data.

If you make a mistake in adding an object, select the node and press [Delete].
This will move it to the Recycle Bin. Bench Top AiL
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To add specific properties to a node, [double-click] it or press [Enter]. Some =
objects have no specific properties, such as a site (and are used only to Eeench Battom RL
organize the structure of the tree), while others have either data or links to 85
external data, or both. An open pit, for example, has specific properties to help oo Height
to identify the location of the bench. [

F1 for Help...

Add Blasts

To add a blast, you must first add a blast collection. There are three collection objects, for
bench, ring and face blasts. Each type of blast can only be added to its relevant collection
object.

To add a blast collection, select the parent node on the tree, then click the blast collection object
on the toolbar.

There are three methods to add a blast:

e add from a blast design module, such as 2DBench;
e import from a JKSimBlast blast database; or

e create the blast as a node.

Add Blast from 2DBench

For this method, both 2DBench and =] Add Blast Reference to JKBMS
JKBMS must be running at the same time  ~Current Blast Design

(the same applies for 2DRing and Datahase Name: [c: iy DocumentsiSoft-Blast 2db
2DFace). Create the blast in 2DBench, Blast hiame: [5100 Blast 1

and save it to a blast database. After you Scenmh—

click the [Save] button in 2DBench, and
with JKBMS running, this dialog will

appear: —Available JKABMS Blast Collections:
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Add Design To current Blast Collection selected in JKBMS

Select the blast collection from the list,
and click the button [Add Design to
selected Blast Collection]. This will
create a link, or reference, in the BMS
database to the blast in its blast
database.

Add Design to selected Blast Collection |

Otherwise, if you have selected the
correct blast collection node in JKBMS,

Close |
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you can click the top button, [Add Design to current Blast Collection selected in JKBMS]. If you
have not selected it, you can go to JKBMS and select it before clicking the button. This is useful
if you cannot determine the correct collection from the list.

You can click either of the [Add...] buttons to add more references to the blast, in any selected
blast collection.

Click the [Close] button to close the dialog.

Import Blasts from a 2DBench Database

Use this method to add blasts that have g .
been previously Saved from ZDBench |

(or 2DRing, 2DFace). l&lg+ilg
[Right-click] on the blast collection node Blast [1atahasze
and select >Add Existing Blasts from |E-\My Documents'blaststBench115. 2db

the pop-up menu. This dialog appears:

Aveailable Designs

Click the [Open...] button to select a
2DBench database, and the blasts in
the database will appear in the list
below. Select the blasts to add; click
with the [Shift] and [Ctrl] keys for
multiple selections, click the [Select
All...] for all blasts, or enter some
characters in the filter at the bottom
and click the [camera] button to select
all blasts with those characters.

[ Only show blasts MOT in thiz BMS Databaze

The check box will limit the list to blasts E blasts selected
that do not already exist in the current
BMS database. [B115 @]

E3JKBMS - C:iMy Documents!Soft-Blast.bms [_|O] %]/ Click the [+] button to add the
selected blasts to the BMS blast

p— collection. This will create a reference
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B115 Blast 2 [Double-click] the blast collection to

B115 Blast 3 = | display all of the blasts, with a plan

E115 Blast 4 view.
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|ID:12 | Blast Collection | Blasts B115

S




JKSimBlast - JKBMS

“§|+v-v|iu::Unknown - $|@<E|

| DBMame | Design | Scenario |
C:A\My DocumentshblastshBenchl15.2db B115 Blast 1 1
C:A\My DocumentshblastshBenchl15.2db B115 Blast 2 1
B115Blast 3 C:A\My DocumentshblastshBenchl15.2db B115 Blast 3 1
B115Blast 4 C:A\My DocumentshblastshBenchl15.2db B115 Blast 4 1
B115Blast & C:A\My DocumentshblastshBenchl15.2db B115Blast 5 1
B115Blast & C:A\My DocumentshblastshBenchl15.2db B115Blast & 1

Double Click to edit blast entry....

[Holes: 54 Ties: 1 [ Plan Wiew

[Right-click] the blast collection node and select >Plan View to show all of the blasts together in
a single plan. The view will show all of the blasts below the node from where it was activated.
Move the mouse over a blast to display its name.
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Create Blast

This option allows you to add a blast to a collection as a node. You can name the blast, and
then choose to import the blast data from a text file, or run the blast design module and create
the blast there.

Select the blast collection, then [right-click] and select >Create New Blast. You will then be
prompted to add the blast to a database — this is similar to saving the blast in the design
module, but it only creates a location for the blast in the database - it does not create any data.

If you select [No] you will have a new blast with no reference. You can [right-click] on the new
blast and select >Properties, then [double-click] the blast name to edit the blast details and
attach a reference to an existing blast.

If you select [Yes], then you must select a blast database where the blast will be linked. Select
the database from the list of current databases, browse for a different database, or create a new
database (you will be prompted for a name and folder).

Depending on your choice, you will then be prompted for a name and scenario number for the
blast. If you enter or choose a blast name that already exists in the database, you will be
prompted to create a reference to the blast. Select [Yes] to continue, or [No] to go back and
enter a different name or scenario.

Next, you will be asked if you wish to run the Design Importer, to import the blast from a text file.
This is the same process as in the design modules to import a blast.

As the final step, the blast design module will open, and will open the new blast if it exists, or
you can create the blast.

Edit the Blast

To edit a blast in the relevant design module, either [double-click] the blast in the collection (if
you have selected the correct option in the program options), or open the Properties in BMS (for
either the blast or the collection) and click the edit icon in the top left corner of the properties
form.

The blast will open in the relevant design module. Any pre-existing data will be lost.

Analyse the Blast

JKBMS cannot perform any analyses within the program, but it can store or reference the
results of analyses from other sources, and these can be viewed in JKBMS. These can be
added to the blast as child objects, as for any other objects.

Some of the useful objects for analyses are:

<] Photo Collection. Each photo is stored as a link to a file, with individual notes. The
photos can be viewed with the internal viewer, or opened in the default viewer application.

H Video Collection. Each video is stored as a link to a file, with individual notes. The
videos can be opened in the default viewer application.

e Vibration. Enter the summarised results for various vibration measurements.
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et Fragmentation Distribution. Enter the fragmentation distribution data (as percent
passing and size), and display as a graph. Several sets of data can be entered, or pasted, and
displayed together for comparison.

b Graph. Store and display time-based data as a graph.

% Energy Distribution. A collection of energy distribution results from a JKSimBlast design
module. The data can be filtered to control the display, and shown in 3D with the blast.

* PPV Damage Contours. A collection of PPV contour results from a JKSimBlast design
module. The data can be filtered to control the display, and shown in 3D with the blast.

= Generic File. Attach any data file with an application that can process it. [Double-click]
to automatically run the application.

These objects are designed to make it easy to recall and display other data associated with a
blast, with all references stored in one location for rapid recall and comparison. For more
information, consult the on-line help.




